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SUMMARY:
The protocol describes standard operating procedure for testing potentially biodegradable materials both synthetic and natural under aerobic conditions using a natural seawater inoculum and automated closed loop respirometry system.

ABSTRACT: 
Proper assessment of biodegradable materials depends on the wide adoption of standard test methods. Although such methods exist, testing capacity remains limited, constrained by cost and the start-up time to establish new laboratories. This modified screening protocol is based on the ASTM International D6691-24a, Standard Test Method for Determining Aerobic Biodegradation of Plastic Materials in the Marine Environment by a Defined Microbial Consortium or Natural Sea Water Inoculum. It assesses the biodegradation of materials in a marine environment, comparing results to positive and negative controls, and uses a natural seawater inoculum supplemented with ammonium and phosphate to prevent nutrient limitation. Materials are exposed to this nutrient-enriched seawater and incubated at 30 °C. A Micro-Oxymax respirometer measures the production of biogas (carbon dioxide, CO2) over time. The degree of mineralization (biodegradation) is determined by calculating the proportion of material-derived carbon converted to biogas-carbon. The percent CO2 production, expressed as a fraction of the measured or theoretical carbon content, is reported as a function of time. The closed-loop respirometry system accommodates a range of reactor vessels, prepared in triplicate for each material, a negative control (seawater inoculum only), and a positive control (thin-layer chromatography cellulose). This method is important for evaluating materials in the marine environment and addresses global pollution prevention.

INTRODUCTION:
Plastic waste poses a threat to marine ecosystems and human health1. The growing concern over plastic pollution, along with marine debris from any materials in the ocean, underscores the need for sustainable solutions, such as improved end-of-life waste management and biodegradable materials that readily biodegrade in the marine environment. Unlike traditional synthetic plastics, which persist for decades to centuries and generate microplastics that accumulate in food webs2-4, biodegradable materials, organic components of carbon, may be metabolized to CO₂ and methane (CH₄), or assimilated into microbial biomass5. Understanding biodegradation of materials in seawater is therefore key for quantifying and mitigating the environmental impacts of marine debris.

[bookmark: _Hlk208135773]Biodegradation in the marine environment is controlled by the interaction of spatiotemporal variables, including light and nutrient availability, pressure, temperature, microbial species composition, and physicochemical nature and structure of the polymer, which all determine the rate, degree, and mechanism of degradation6. These variables present a significant challenge for laboratory-based biodegradation studies simulating marine environments. This standard operating procedure (SOP) uses natural seawater as the inoculum, capturing the in situ microbial community present, and records relevant variables including seawater dissolved nutrients, particulate carbon and nitrogen, chlorophyll, salinity, pH, and temperature. This controlled laboratory-based approach optimizes conditions for promoting mineralization and allows for direct biodegradation measurements that are not feasible in situ. The ASTM International D6691-24a, Standard Test Method for Determining Aerobic Biodegradation of Plastic Materials in the Marine Environment by a Defined Microbial Consortium or Natural Sea Water Inoculum (hereafter ASTM D6691), and this SOP were developed as a rapid, reliable screening tool for assessing the biodegradability of materials7-10.

[bookmark: _Hlk208136524]Aligned with ASTM D6691, a screening test for inherent polymer biodegradability, this protocol evaluates biodegradation of materials under optimal conditions, 30 °C, maximum surface area from milled sample, and excess inorganic nutrients (nitrogen, 130 mg/L; phosphorus, 23 mg/L)9, to promote mineralization and prevent nutrient limitations. While screening tests offer valuable initial insights, further testing, such as coastal and deep-sea moorings, which measure weight loss as a function of time, might be necessary for a comprehensive evaluation under natural marine conditions. Since these coastal and deep-sea mooring tests estimate biodegradation based on weight loss as a function of time10, 11, researchers should first perform this screening test, which directly measures microbial metabolism, before going to an in situ coastal and deep-sea mooring experiment, which is also more expensive.

The ASTM D6691 standard test method outlines procedures for evaluating the aerobic biodegradation of non-floating plastic materials in marine environments. This standard, along with specification standards, such as ASTM D7081 (Standard Specification for Non-Floating Biodegradable Plastics in the Marine Environment; focusing on biodegradability in an aqueous medium, currently withdrawn from ASTM and being reballoted), provides a framework for certifying experimental polymers as marine biodegradable9,12. In general, a specification is a consensus standard from ASTM International that sets requirements that a material, product, or system must meet. It ensures that materials designed to biodegrade in marine environments do so within acceptable timeframes and do not release potentially toxic additives, such as dyes or plasticizers.

Building on ASTM D6691, this protocol quantifies the rate and degree of aerobic biodegradation of materials (experimental substrate) in natural seawater and expands on positive material controls (i.e., cellulose, Kraft paper, chitin/chitosan), historically shown to be biodegradable in the marine environment7,9,10. The goal of this method is to screen materials under optimized conditions to see if the materials biodegrade in the marine environment. The inoculum leverages the natural microbial community present in the seawater, collected following specific guidelines outlined in ASTM. These guidelines emphasize using seawater with a salinity of approximately 32, collected from a location free from pollutants like sewage, chemical dumping, or oil spills. The test uses an automated closed-loop respirometer with 250 mL reactor vessels maintained at 30 °C, each containing 75 mL of seawater and ~20 mg of the experimental or control substrate8. Mineralization (biodegradation) is expressed as the percentage of net carbon biogas (CO₂-C) produced relative to the initial carbon mass added. This method does not account for carbon assimilation into microbial biomass.

PROTOCOL:

1. Collection and characterization of seawater

1.1 Identify a seawater collection site unaffected by wastewater, chemicals, oil slicks, or strong freshwater influence.

1.2 At the collection site, record source (location, latitude and longitude, collection depth, total depth, and temperature), date of sample collection, and observed water conditions.

1.3 Collect and combine seawater samples from multiple depths, site locations, and sampling events to promote a diverse microbial community composition.

1.4 In a 20 L acid leached carboy, collect 10 L to 20 L of seawater using a large Niskin bottle, and transport back to the laboratory.

1.5 From the carboy, transfer 1 L of whole seawater subsample into an acid-leached 1 L amber high-density polyethylene (HDPE) bottle for laboratory analysis of particulate carbon and nitrogen for initial seawater conditions. From the 1 L sample, filter (0.2 µm; low nitrogen cellulose acetate) and collect a 60 mL subsample in an acid-leached polyethylene bottle for analysis of dissolved inorganic and organic nitrogen (N) and phosphorus (P) constituents. 

1.6 [bookmark: _Hlk208138553]Label subsamples with project name, sample ID, and date. Measure NH₄⁺ concentrations using the indophenol method (4500-NH3)13,14 and PO₄³⁻ levels using the single solution method (4500-P E)13,15. Quantify particulate nitrogen and carbon using the elemental analysis method16. Measure chlorophyll-a concentrations following the protocols outlined by Parsons et al.17 (10150 A, 10150 C)13. 

NOTE: Nutrient-related water quality analyses are optional. This protocol assumes analyses are conducted by an outside laboratory.

1.7 Loosely cover the carboy opening to maintain aerobic conditions and store seawater at 30 °C in the dark for up to 7 days. 

NOTE: Seawater may also be aerated using an air pump and bubbler system.

2 Preparation of experimental substrate

2.1 Add 10–15 g of experimental substrate (i.e., natural polysaccharides, wood, fiberboard, polymers) that may be in the form of pellets, fragments, and formed pieces to a 50 mL stainless steel milling jar with a 20 mm steel ball. Mill the experimental substrate to a uniform particle size (0.10-0.25 mm) prior to the start of the test.

2.2 Submerge the milling jar in liquid nitrogen and embrittle for 15 min until the liquid nitrogen stops boiling. 

CAUTION: Liquid nitrogen is a cryogenic liquid that may cause burns, injury, or frostbite. Read and follow all Safety Data Sheets before use. Wear appropriate personal protective equipment.

2.3 Secure the milling jar in the ball mill attachment and set the instrument parameters to 30 Hz and 2:30 min, and press Start. Repeat 4x with 30 s cooling in liquid nitrogen in between trials. If the material is a polymer with a low glass transition temperature, perform additional milling cycles as necessary to produce a uniform particle size distribution.

2.4 [bookmark: _Hlk208140231]Verify size uniformity and characterize particle size distribution by sieve analysis as described in18. Assemble standard sieves spanning the expected particle size range, with the smallest mesh size on the bottom. Place the milled sample on the top sieve and secure the sieve stack in a mechanical shaker. Agitate until particles pass through the mesh. Collect and weigh the retained material from each sieve to calculate particle size distribution. Use the same set of sieves across treatments to maintain comparability. Record the distribution on the data sheet.

2.5 Determine carbon content per subsample dry weight of the milled experimental substrate by elemental analysis16.

NOTE: This protocol assumes elemental analysis is conducted by an outside laboratory.

3 Preparation of the additional nutrients for seawater

3.1 Fill a 2 L or 4 L volumetric flask halfway with seawater. The total volume needed depends on the number of reactor vessels to be used in the experiment. Each reactor vessel will contain 75 mL of seawater. If the seawater source contains high concentrations of particulate organic matter, sieve the seawater through a 20 µm mesh to eliminate heterogeneous contamination by large particulates.

3.2 Using a precision balance with sensitivity to 0.001 g, tare a weigh pan and weigh out 0.5 g/L ammonium chloride (NH4Cl) and then 0.1 g/L potassium phosphate monobasic (KH2PO4) based on 2 L or 4 L of seawater.

CAUTION: Ammonium chloride can cause eye damage or irritation. Read and follow all Safety Data Sheets before use and wear appropriate personal protective equipment.

NOTE: Dispose of ammonium chloride and potassium phosphate monobasic waste in dedicated hazardous waste containers per institutional procedures and local regulations. Small volumes of dilute (<1%) NH₄Cl and KH2PO4 solutions may be eligible for drain disposal after dilution with copious water, if permitted by the institution and local wastewater authority.

3.3 Add the inorganic nutrients to the 2 L or 4 L volumetric flask, bring to volume with seawater, add a stir bar, and stir on a stir plate until all salts dissolves. The solution should be clear with no visible particulates.

3.4 Subsample 20–30 mL of the nutrient-supplemented seawater for pH and salinity measurement. Filter an additional 60 mL through a 0.2 µm low-nitrogen cellulose acetate filter into an acid-leached polyethylene bottle for dissolved inorganic N and P analysis following the standard methods in step 1.5. 

3.5 Measure pH and salinity on a benchtop meter following the manufacturer’s instructions. A pH decrease of approximately one unit is expected for full-strength seawater due to the acidity of the nutrient supplement.

4 Preparation for reactor vessel incubation

4.1 Acid leach all glassware, including 250 mL reactor vessels for the samples and 75 mL volumetric pipette in 10% hydrochloric acid (HCl) for 24 h and rinse 3x with deionized water. 

CAUTION: HCl may cause severe burns and eye damage. Read and follow all Safety Data Sheets before use. Wear appropriate personal protective equipment.

NOTE: 10% HCl waste can be neutralized with sodium bicarbonate to form a neutral solution prior to disposal. Perform neutralization in accordance with institutional hazardous waste procedures and applicable local regulations.

4.2 Autoclave the acid-leached 250 mL empty reactor vessels, lids with ports, silicone seal O-rings, and screw caps in an autoclave at 121 °C for 15 min prior to the day of the experiment.

4.3 Label sample vials with the channel number/ID corresponding to vessels receiving sample or control materials. 

4.4 Using the analytical balance, tare a vial (with cap) and weigh out 20 mg (± 0.1 mg) of the experimental or control, and record the full readout weight, and set aside. Repeat for all experimental and control replicates. 

NOTE: Be sure weights are accurate. It is recommended to weigh all substrates on the same day and by the same person.

4.5 Turn on the incubator the day prior to adding vessels and set the temperature to 30 °C. Turn on the respirometer at least 2 h prior to running system diagnostics and sensor calibration based on manufacturer instructions. 

[bookmark: OLE_LINK1]NOTE: Reactor vessel preparation can proceed once the incubator temperature reaches and maintains 30 ± 2 °C.

4.6 Prepare the data sheet by recording sample IDs/replicates and the corresponding channel number. Organize the reactor vessels and cap assemblies (lid with ports/O-ring) in order of channel number/ID (make sure each vessel is clearly labeled). Check the O-rings and lids/ports to ensure they are clean, dry, and intact.

5 Setting up the reactor vessels

5.1 Use an acid leached 75 mL volumetric pipet and motorized pipet controller to dispense 75 mL of nutrient supplemented seawater into each reactor vessel.

5.2 Remove one disposable pipette worth of seawater (~3 mL) from each vessel and set it down on a clean surface next to it. This seawater will be used to rinse the milled experimental and control substrates from the tared vial (Figure 1).

5.3 Transfer the substrates into appropriate vessels.

5.4 Place an O-ring on the reactor vessel rim, then place a two-port lid directly on top of the O-ring. Secure the O-ring and lid in place with a screw cap. 

5.5 Match the reactor vessel to its corresponding gas/condensation lines. Firmly insert the gas lines into the appropriate inlet/outlet ports in the vessel lid.

5.6 Turn on the shaker platform to 0.05 x g (continuous mode). Conduct a visual check to ensure all vessels are secure, then close the incubator door.

5.7 Record incubator temperature (readout and thermistor probe) and atmospheric pressure using a barometer.

[Place Figure 1 here]

6 Starting the respirometry system

6.1 Launch the software on the connected computer. Verify that the system detects the hardware through the RS-232 connection. If the hardware is not found, a notification will indicate that the device is not connected, and the program must be restarted.

6.2	In the software main menu, select Tools > Diagnostics > Basic Operations. Click Save log file. Click Valves and Sensors. The software will indicate PASS or FAIL for each test. Proceed to two-point calibration of the CO2 sensor only if both tests pass.

7 Calibrating the CO2 sensor

7.1 Connect a soda lime column to the nitrogen port on the sample pump back panel to remove ambient CO2 for zero calibration. Ensure soda lime appears chalky white and not discolored (e.g., pink or purple).

7.2 Select Tools > Calibration. Click Start Calibration in the lower right corner. When prompted, adjust the sample flow to 0.5 L/min using the front panel sample pump control. Click OK.

7.3 When the timer reaches zero, press the Up and Down offset buttons on the CO2 sensor to adjust the reading on the screen to 0.000 (or as close as possible). Values will turn green when within the acceptable range. Click Next Gas.

7.4 When prompted, connect the calibration gas cylinder to the calibration port on the sample pump back panel. Adjust the calibration gas outlet pressure to 5 PSIG. Ensure excess gas flows through the T fitting whereby the user can hear and feel the gas near the fitting, before clicking OK.

7.5 When the timer reaches zero, press the Up and Down span buttons on the CO2 sensor to adjust the reading on the screen to 2.700 (or as close as possible). Values will turn green when within the acceptable range. Click Next Gas to complete the calibration.

NOTE: Span gas concentrations are determined by the certified primary standard gas mixture, as documented in the supplier’s certificate of analysis.

8 Experiment setup in software

8.1 Select Experiment > Setup. Enter start and end channel numbers from the drop-down menus based on occupied channels. 

8.1.1 Set Refresh Threshold (%) to 0.50, Refresh interval to N.A., and Refresh Window (sec) to Auto. 

8.1.2 Under Misc Setup, check the box for Purge Sensors; ensure Auto Volume Measurement, O2 Consumption Positive, and Enable Open Flow Mode are not selected. 

8.1.3 Set Sample Interval (Hours) to 8.00 and Experiment Duration (Hours) to N.A. Set gas and time units as needed. 

8.1.4 If using the primary temperature probe for incubation temperature correction, ensure Manually Enter Chamber Temps is not selected. Check the box for Venting Mode and ensure Drain Mode is not selected. 

8.1.5 Ensure Anaerobic Venting Mode is not selected.

8.2 Select Chamber Setup. Enter descriptive channel labels (e.g., NegCtrl_1, PosCtrl_2, Test_PHA_3).

8.3 Click Utilities. Click Cells in the EN Column for occupied channels only. Click Restriction. The software will indicate PASS or FAIL for each channel. Proceed only if all restriction tests pass.

8.4 Click Volume to measure headspace volumes. 

NOTE: Headspace volume equals the volume of the air within the sample reactor vessel and closed-loop tubing. Confirm volumes are reasonable for vessel size and tubing length.

8.5 Click Leakage. The software will indicate PASS or FAIL for each channel based on the headspace volume. If a channel fails, perform the following steps.

8.5.1 Ensure the O-ring is clean and free from particles and fibers and properly seated between the vessel rim and the metal lid.

8.5.2 Tighten screw cap. Check the connection and tubing at the IN/OUT ports and fittings. Trim worn or deformed tubing ends with a sharp blade to ensure a clean, straight cut.

8.5.3 If the channel continues to fail, replace the O-ring with a new, compatible one specified by the manufacturer.

8.6 Click Volume to remeasure headspace volumes. Click Quit. Ensure the Volume column of the Chamber Setup tab is populated for all occupied channels.

8.7 In the main menu, select Tools > Service Menu. Confirm that the primary temperature probe, measuring the incubator temperature, is at 30 °C ± 2 °C and stable.

8.8 Click Run. Save the file using a descriptive name that includes the date (e.g., 030325PositiveControlValidation). Record the filename on the data sheet. 

8.9 Select Experiment > View > Graphing to view real-time plots. Biogas production appears as positive CO2 production rates. Negative controls may fluctuate about zero; however, their average rate should be zero or positive.

8.10 If the system includes condensing air driers, maintain a daily log of visible condensation in tubing. Gently agitate tubing to disrupt blockages and allow drainage, if necessary.

8.11 Update data files (ASCII Text Files) at the end of each sampling interval. Data, including temperature, gas % (gas composition), rate, and accumulation, can be downloaded to various other software packages during the experiment or at the end. 

8.11.1 To open .dat files in a spreadsheet, launch Excel and select File > Open. Navigate to the folder containing the .dat file. In the file type drop-down menu, select All Files and choose the desired file.

8.11.2 When prompted by the Text Import Wizard, select Delimited as the file type and click Next.

8.11.3 Under Delimiters, check the box for Comma. Ensure no other delimiters are selected. The preview window should display data separated into columns. Click Finish to load the data into the spreadsheet.

8.11.4 Save the file as an .xlsx or .csv format for further analysis and archiving.

8.12 Periodically, analyze data to ensure treatment replicates are consistent. Standard error of treatment replicates should be less than 5% of the mean cumulative CO2 production. Repeat tests failing this threshold.

8.13 Click Stop when incubation is complete.

8.13.1 Incubations can last 10–90 days. If test materials are highly biodegradable, terminate the incubation when cumulative CO₂ production plateaus or extend it if no degradation is observed after 90 days.

8.13.2 Conclude experiments when no net gas production is observed for at least 5 days in both control and test vessels. No net production is defined as less than 1% change in percent biodegradation over 5 days.

8.14 Shut down the system or prepare for the next experiment.

9 Breaking down the experiment

9.1 Record incubator temperature (thermistor probe and incubator readout). Disconnect the tubing from the reactor vessels from the respirometer and weigh each sample reactor vessel using a precision balance. Record weights to determine if any weight/water loss occurred over the incubation period.

9.2 Subsample 20–30 mL of seawater from each reactor vessel to measure pH and salinity and compare these values to those recorded in step 3.4 to verify stability during incubation. Filter an additional 60 mL through a 0.2 µm low nitrogen cellulose acetate filter into an acid-leached polyethylene bottle for dissolved inorganic N and P analysis following standard methods in Step 1.5. 

NOTE: Residual seawater samples can be filtered to remove remaining plastics, diluted to reduce nutrient concentrations, and disposed of by drain discharge in accordance with institutional and local regulations.

9.3 Rinse vessels, O-rings, metal lids, and screw caps with tap water. Place glassware in a 10% HCl acid bath for at least 24 h. Autoclave and store covered in aluminum foil for the next incubation 

10 Calculating percent biodegradation

10.1 Calculate the total carbon in the experimental/control substrate as follows:


where % C (carbon content) is determined through elemental analysis.

NOTE: Total carbon in the experimental and control substrates can undergo the following biochemical transformation during the aerobic incubation: 
C + O2 → CO2
Each mmole (12 mg) of organic carbon from the experimental/control substrate can be converted into 1 mmol of gaseous CO2. One mmole of gas produced occupies 22.4 mL at standard temperature and pressure (STP).

10.2 Calculate the percent biodegradation as follows:


where Cg = amount of gaseous carbon produced from the experimental/control substrate and negative control (seawater inoculum only), mmoles, and Ci = amount of carbon in experimental substrate added, mmoles.

10.3 Calculate the standard error, se, of the percentage of biodegradation as follows:

where n1 and n2 = number of replicate experimental/control substrate and negative control reactor vessels, respectively, and s = standard deviation of the total gaseous carbon produced.

10.4 Calculate the 95% confidence limits (CL) as follows:

where t = t-distribution value for 95% probability with (n1 + n2 − 2) degrees of freedom, thus n = 3 + 3 − 2 = 4.

11 End of protocol

11.1 After completing calculations and data analysis, compile results into the final report or enter them into a shared database in accordance with project or institutional data management plans. Ensure all materials are disposed of according to institutional hazardous waste guidelines, and all equipment is cleaned and stored. 

RESULTS:
The results from marine biodegradation tests are presented. Biodegradation was assessed for each sample by measuring the proportion of carbon converted to carbon dioxide. Cumulative, rate, and percent biodegradation plots typically exhibit a lag phase, followed by a growth phase, and eventually a plateau. The timing and magnitude of these phases depend on the sample material, experimental conditions, and the composition of the seawater inoculum.

Seawater collected year-round from a temperate embayment exhibits variability in water quality constituents. For example, microbial community diversity and abundance vary on day-to-season time scales19,20. Additionally, the presence of labile organic carbon in the seawater inoculum can drive heterogeneity of carbon dioxide production among replicates. Organic carbon, particularly slow-degrading particulate organic carbon, can influence the availability of carbon to the microbial community21. While this heterogeneity may not affect the degree of biodegradation, it can affect the variance of the replicates, potentially reducing the robustness of the results. 

Table 1 and Figure 2 present representative positive results from a biodegradation test. Figure 2 illustrates the application of the closed loop respirometry method to measure aerobic biodegradation of two materials, microcrystalline cellulose (positive control) and polyhydroxyalkanoates (PHA), in natural seawater, compared with a negative control (seawater inoculum only). In Figure 2A, cumulative CO₂ production over an 84-day incubation shows the expected performance of the technique: the cellulose control exhibited a rapid increase in CO₂ production following a < 1-day lag phase, reaching a plateau near 700 µmol by the end of the test. This confirms that the seawater inoculum was active, and experimental conditions were favorable for biodegradation. Similarly, the PHA treatment displayed a rapid increase in CO₂ production, with a slightly lower CO₂ production rate during the approximately 3 days of incubation. In contrast, the negative control remained low, producing approximately 150 µmol CO₂ during the incubation, indicating minimal background mineralization. Figure 2B expresses the same data as the negative control corrected percent mineralization relative to the theoretical CO₂ yield (i.e., percent biodegradation), allowing direct comparison between materials. Researchers can use these cumulative CO₂ production curves to verify control performance, assess lag times, compare biodegradation rates, and identify anomalies (e.g., unexpected rate spikes or suppressed production). Together, these results demonstrate the technique’s ability to test materials with varying biodegradation potentials and to confirm test validity through consistent positive and negative control performance.

Results should be monitored throughout the incubation to ensure consistency between treatment replicates. The standard error of each treatment should remain below 5% of the average cumulative CO2 production. In the representative dataset (Table 1), the standard error of the negative control average cumulative CO2 production was 2.5%. Individual negative control replicate curves are presented in Figure 3A. The cellulose positive control replicates also demonstrated low variability, with a standard error of 0.83% (Table 1; Figure 3B). 

Representative negative results are illustrated in Figure 4A,B. These plots of cumulative CO2 production highlight high variability among the negative control replicates, which may indicate heterogeneity in the seawater inoculum or a technical issue with the respirometry system. For example, replicate 4 exhibited an anomalous spike in CO2 production rate, likely attributable to labile organic matter unique to that replicate. While this rate spike affected the timing of the growth phase, the cumulative production ultimately plateaued near 100 µmol, which is comparable to the other replicates. On the other hand, replicates 1 and 6 had lower cumulative CO2 production, suggesting possible system leaks or clogs. Both examples of negative results emphasize the importance of real-time monitoring to quickly identify and resolve performance issues during the test.

FIGURE AND TABLE LEGENDS:
Figure 1: Vessel setup and preparation. (A) Adding seawater, (B) adding the sample, and (C) adding the O-ring, metal lid, and screw cap.

Figure 2: Positive results of biodegradation of cellulose and polyhydroxyalkanoates in natural seawater. (A) Cumulative CO2 production over 84 days, averaged across replicates with standard error. (B) CO2 produced as a percentage of the theoretical maximum, indicating percent mineralization. Shading on each curve represents the standard error bar. 

Figure 3: Positive results of CO2 production rates in natural seawater. (A) CO2 production rate over 30 days for 4 negative control (seawater inoculum only) replicates. (B) CO2 production rate over 30 days for 4 microcrystalline cellulose positive control replicates.

Figure 4: Negative results of CO2 production rates in natural seawater. (A) Cumulative CO2 production over 30 days for 6 negative controls (seawater inoculum only) replicates (B) CO2 production rate over 30 days for 6 negative control replicates.

Table 1: Positive results corresponding to Figure 2. CO₂ production and mineralization of cellulose (positive control) and PHA (experimental substrate) over an 84-day incubation. Seawater collected from Clark’s Cove, New Bedford, MA (41.594180°, –70.911231°). Abbreviations: PHA = polyhydroxyalkanoates. Values are means ± standard error (SE) for n = 4 replicate sample reactor vessels.

Table 2: Troubleshooting guide for positive and negative controls in closed-loop marine biodegradation tests. Common issues, likely causes, and recommended corrective actions for positive controls (e.g., analytical grade cellulose, Kraft paper, etc.) and negative controls (e.g., seawater inoculum only). Implementing these actions can help ensure control performance meets acceptance criteria and supports test validity.

DISCUSSION:
Positive-control performance determines test validity. A minimum of 70% biodegradation of a readily marine biodegradable positive control substrate (e.g., analytical grade cellulose, Kraft paper, etc.), based on its theoretical maximum gas yield, is required. This benchmark verifies favorable conditions and sufficient microbial activity in the natural seawater during the incubation. Failure to meet this threshold indicates a potential issue with replicate preparation, seawater inoculum handling (i.e., microbial community die off), or respirometry system function, requiring test invalidation. 

To minimize variability associated with replicate preparation, all sample materials should be in the same physical form with a mean particle size less than 0.25 mm. Differences in physical form, thus variation in surface area available for microbial attack, can affect the degree and rate of mineralization. If substrates are cryogenically milled, the particle-size distribution should be consistent and verified using a sieving apparatus or a particle-size analyzer. When materials with comparable physical properties are milled using a standardized protocol (e.g., a fixed number of cycles and frequency), particle sizes are typically consistent. Consistent particle size across materials is strongly recommended to ensure comparability between treatments and tests.

A common source of experimental error is an inaccurate or inconsistent mass of polymer added to the sample reactor vessel. To reduce errors, all material samples should be weighed on the same day by the same technician using a properly calibrated analytical balance. To ensure the complete transfer of the sample material into the reactor vessel, rinse the sample vial with a disposable pipette and inspect both the vial and vessel walls for residual particulates. 

The protocol specifies a minimum of triplicate replicates, although 4–6 replicates are often run for controls to improve statistical robustness. In cases where experimental substrates are inherently heterogeneous, such as those containing additives, polymer blends, or variable crystallinity, larger standard error values may occur. These cases require careful interpretation, as the observed variability may reflect true differences in biodegradation behavior rather than experimental error. Outliers are identified and excluded when their cumulative CO₂ production curves deviate substantially from the other replicates in both magnitude (i.e., standard error greater than 5% of the average cumulative CO2 production) and shape. If a single replicate in a triplicate set is excluded, the mean is calculated from the remaining duplicates. For novel or unknown materials, additional replicates are recommended when vessel space allows.

Furthermore, variability among the negative control replicates suggests heterogeneity in organic carbon content, which may be mineralized and contribute to CO2 production. Seawater collection site and season can affect the microbial community present, but also the influence of particulate and dissolved seawater constituents that may affect the biodegradation processes, whether accelerating or inhibiting (i.e., concentration of labile organic carbon). If seawater has high particulate organic matter, pretreatment of seawater, such as sieving through a 20 µm mesh followed by storage for up to 7 days at the incubation temperature, can help reduce large heterogeneous particulates via removal and mineralization. Ideally, the natural seawater will be sampled for background water quality constituents such as total organic carbon, nitrogen, phosphorus, temperature, salinity, and pH. While the pH of seawater is well buffered, initial and final pH measurements can help troubleshoot an issue if it arises (i.e., an increase in dissolved carbon dioxide). 

Residual carbon from previous experiments can also introduce variability among replicates. Standardized cleaning procedures and proper training minimize variation among replicate samples. Ensure the vessels are clean and free of biofilm residues from previous incubations or glassware use. All vessels should be scrubbed with detergent, visually checked for cleanliness, then acid-leached and autoclaved. 

Conversely, when there is a lack of carbon, like in low-carbon seawater, negative controls may fluctuate about zero; however, their average rate should be zero or positive. For long-term incubations with low baseline CO2 production, it may be necessary to include a soda lime column to scrub ambient CO2 from the refresh gas and prevent negative CO2 rates in the negative controls. Further, extending the sampling interval will help prevent negative rates and increase the sensitivity of the measurements. An 8 h sampling interval proved effective for routine samples and coastal Massachusetts seawater. 

Equally important to controlling baseline CO2 is confirming the closed-loop system is leak free. Thorough leak testing of the closed-loop respirometry system prior to experimentation will prevent irregular results and underestimation of CO2 production. The closed-loop respirometer is modular, supporting a range of 20 to 80 channels to hold individual vessels. To optimize efficiency, multiple samples (run in triplicate) can be analyzed concurrently using a single set of negative and positive control vessels (one set containing three replicates each of positive controls and negative blanks). 

Last, as tests are completed, it is good practice to compile control data from sequential tests into a database and establish an average biodegradation curve with confidence intervals for both positive controls. Compiled biodegradation curves provide a baseline reference to which to compare data in real time. Real-time monitoring of biodegradation allows for early detection and troubleshooting of performance issues. Including a fast-degrading positive control, such as glucose, can provide rapid feedback on test performance and the viability of the seawater inoculum7,9. Other positive controls, such as polyhydroxyalkanoates (PHA), known to biodegrade in the marine environment, can be tested as benchmark polymers for comparison to experimental substrates. 7,9 Control troubleshooting information is summarized in Table 2.

[Place Table 2 here]

This screening test provides limited insight into the long-term persistence of a polymer in the marine environment. Results reflect only the extent of biodegradation that occurs within the specified incubation period. For example, if an experimental substrate demonstrates 10% biodegradation over 10 days, it cannot be assumed it will reach 20% after 20 days. Assessing the long-term fate or complete biodegradation of a material requires longer incubation durations or additional studies. 

The use of natural seawater inoculum offers a natural microbial community but also introduces variability that can influence biodegradation rates, particularly across different seasons and laboratories. While baseline correction to the negative control eliminates most seasonal variability, fluctuations in microbial composition and abundance, particularly in temperate zones, can affect lag phases, mineralization rates, and overall biodegradation extent. To increase diversity of the microbial community and improve reproducibility, laboratories may consider pooling seawater collected over multiple days or tidal cycles to create a more representative and comprehensive inoculum. Keep detailed records of seawater collection location, date, time, tidal stage, environmental conditions, and proportions of collected seawater sample in the combined inoculum. Last, the use of a natural seawater inoculum compared to defined microbial consortia can hinder interlaboratory data comparison due to variations in the microbial communities used. However, the use of natural seawater can reduce biodegradation test cost and effort if seawater is readily accessible. 

The negative control in this method is the seawater inoculum alone because it establishes a no-added-carbon baseline for subtracting background mineralization. Because the physical interface of a substrate can influence microbial activity, laboratories may optionally run a pure, additive-free polyolefin (high-density polyethylene, HDPE, or polypropylene, PP) in parallel as a non-biodegradable polymer negative control. This reference is processed identically to experimental or positive control substrates to assess surface effects. It does not replace the seawater only negative control and should not be used for baseline subtraction. It should remain near 0% mineralization for the duration of the test.

Furthermore, microbial community testing was outside the scope of this study and is not required for this screening protocol. Marine communities are highly diverse and temporally dynamic. We designate the microbial population in the seawater as the indigenous or natural population in the ocean sample that we use for each experiment. The protocol relies on functional safeguards, positive control performance (≥70% mineralization within the test window), and baseline correction to seawater negative controls to interpret results across inocula. That said, documenting the temporal variability of control performance and its potential influence is valuable. We recommend standardized inoculum collection (e.g., pooling seawater across days), detailed metadata (date/time, location, temperature, salinity, nutrients), and, when resources allow, optional characterization (e.g., preserving filters for later 16S analysis and measuring organic carbon) to contextualize results during lab setup, comprehensive assessment of biodegradability, or troubleshooting.

Finally, our method aligns closely with ASTM D6691 in its core approach, including the use of natural seawater inoculum, aerobic incubation conditions, and quantification of mineralization through CO₂ production9. However, while ASTM D6691 focuses specifically on non-floating plastic/polymeric materials, our protocol also accommodates natural materials. In addition, it incorporates multiple positive control substrates (e.g., glucose, polyhydroxyalkanoates) to provide performance benchmarks, allows flexibility in reactor vessel size, and includes optional water quality analyses (e.g., dissolved inorganic nutrients, chlorophyll, pH) to provide environmental context. The goal of this manuscript is not to contradict the ASTM D6691 methodology, but rather to broaden its application and provide an accessible, detailed protocol that can fast-track the establishment of new marine biodegradability testing laboratories. By building on an established ASTM framework, this method supports consistency across laboratories while meeting the growing demand for biodegradability testing, certification, and regulation, thereby promoting transparency and accuracy in marketing claims.

A limitation of this method is that it quantifies only the fraction of substrate carbon that is mineralized to CO₂ and does not account for carbon assimilated into microbial biomass. For materials that are partially assimilated rather than fully mineralized, the calculated percent biodegradation may underestimate the total extent of microbial utilization. While isotope-labeling approaches can track both mineralization and assimilation, these techniques remain cost-prohibitive for routine testing due to the need for synthesizing and radiolabeling the test material. Consequently, this protocol is best applied as a screening tool for mineralization potential under controlled laboratory conditions, with the understanding that complementary analyses may be required for a comprehensive assessment of biodegradability.

Isotopically labeled carbon in materials and subsequent analysis of biodegradation can provide a direct measurement of the conversion of polymer-C to carbon dioxide-C. It is true that isotope-labeled carbon has been identified as the best method for direct biodegradation measurement22; however, it further constrains standardized testing for marine biodegradability. Incorporation of isotopic labeling of carbon into biodegradation standard test methods would likely make testing cost-prohibitive for industry. Therefore, this would further reduce the testing throughput of commercially marketed biodegradable materials. While the ASTM D6691 standard method directly measures biodegradation, it corrects for biodegradation of non-polymer carbon (e.g., ambient particulates) by baseline correction using negative controls. 

Therefore, while there are limitations to this accelerated screening method, it holds significant value in directly measuring biodegradation under aerobic marine conditions. The usefulness of this method stems from its shorter duration due to warm incubation temperature, which allows for higher throughput for the final material as well as the virgin components, because laboratories have limited capacity for these long-duration tests. Proper use of this test requires clear communication to clients regarding test results and their application. Reporting of results must be clear and include robust data on variables such as material form, temperature, humidity, and other environmental conditions23. 

This seawater biodegradability test offers a standardized tool for researchers in various fields. First, it allows for the efficient evaluation of multiple samples simultaneously and provides robust data for understanding the degradation behavior of materials in the marine environment. This is particularly valuable in material development and parallel toxicity testing, where researchers might have numerous prototypes of a biodegradable sample. Testing them concurrently using this method provides crucial data to identify the most promising candidates for further development. Second, the respirometry system's ability to measure low levels of carbon dioxide enables real-time monitoring of biogas production. Finally, this method provides opportunities for parallel measurements, such as tracking of isotope-labelled carbon and destructive sampling throughout the test, allowing for the application of omics approaches, which are powerful techniques for analyzing the entire set of genes, transcripts, or proteins within a microbial community. These omics analyses can provide valuable insights into the underlying mechanisms of biodegradation by the seawater microbial assemblage. 
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